User Guide
In this User Guide, we show you how to use Wakanda Studio to do the following:
Creating a Wakanda solution and its project(s)
Defining user access to your app
Developing your app's data model
Prototyping your app
Creating your Web app
Creating your mobile app
Creating a Wakanda solution and its project(s)
In Wakanda, you must first create a before adding a Project to it. In each project, you create a prototype, build a web app, and build a mobile app.
Solutions

For solutions, discover how to:
Create a new solution,
Open an existing solution, and
Close a solution.
Projects

For projects, learn more about how to:
Create a project,
Add a project to a solution, and
Remove a project from the solution.
For more advanced users, you can also learn how to Create a JS module for your project.
Defining user access to your app
You define users and groups in your solution's Directory. Once you have your Directory set up, you can define the Permissions for your Model.
Groups

For groups, we show you how to:
Add a group,
Remove a group, and
Include a group in a group.
Users

For users, we show you how to:
Add a user,
Remove a user,
Add a user to a group, and
Remove a user from a group.
Developing your app's data model
In Wakanda Studio, you can develop your data model by defining the datastore classes and attributes as well as define relations between datastore classes
using the Data Model Editor or the Model API.
Datastore classes

For datastore classes, learn how to:
Create a datastore class,
Create an N<‐>N relation,
Extend a datastore class,
Rename a datastore class, and
Delete a datastore class.
Attributes

For attributes, learn how to:
Create a scalar attribute,
Create a calculated attribute,
Create an N‐>1 relation attribute,
Create a 1‐>N relation attribute,
Create a recursive relation attribute,
Create an alias attribute,
Remove an inherited attribute,
Override a property of an inherited attribute, and
Delete an attribute.
Datastore Class Method

After you create a datastore class, you can create a method that can be applied to an entity, the datastore class, or the collection. For more information,

refer to Create a datastore class method.
Permissions

After you define groups in your solution's directory, you can define the permissions for the model, datastore classes, attributes, and datastore class methods.
We show you how to:
Define permissions,
Force temporary permissions, and
Delete permissions.
Prototyping your app
In the Prototyper, you can prototype your app by creating Page Prototypes on which you add Widgets that are bound to Datasources to display the data in
your data model.
Page Prototype

In this chapter, we show you how to use Page Prototypes in your project. You will learn how to:
Create a Page Prototype,
Create a View for a Page,
Run a Page Prototype, and
Debug a Page Prototype.
Widget

For your Page Prototypes in your project, discover how to:
Add a Widget to the Page Prototype and
Delete a widget from the Page Prototype.
Datasource

Datasources are used to bind data from your Model to a widget on a Page Prototype. In this section, we show you how to:
Create a datasource,
Duplicate a datasource, and
Delete a datasource.
Creating your Web app
You can build your Web App (which can be displayed on desktop computers) in your project's app/web folder. Here we will show you how to:
Edit your Web app's main HTML file,
Edit your Web app's main JS file, and
Run your Web app.
Creating your Mobile App
Build your Mobile App with the files in your project's mobile folder. In this manual, you will learn how to:
Edit your mobile app's main HTML file,
Preview your mobile app,
Run your mobile app, and
Build your mobile app.

Solution
In this chapter, we show you how to create, open, and close a Wakanda solution in Wakanda Studio.
For more information about solutions, refer to the Solution chapter.

Create a new solution
To create a new solution:
1. Select Create a New Solution in the Home tab or select New‐>Solution from the File menu.

2. Specify a name for your solution.

3. Define a location on your hard disk where you want to save it.
4. Click on the OK button.
Check the Add a blank project to the new solution option, if you want to add a project with the same name as the solution. The new solution with its new
project appears as such in the Solution Explorer:

If you don't create a blank project with your new solution, it appears as shown below:

Check the Create a Git repository option, if you want to create a Git repository for the solution in the same folder as your solution.The new solution appears
as shown below:

For more information about the Git repository for your solution, refer to Local Git Repository.
You can either Create a project or Add a project to a solution for your solution at any time.

Open an existing solution
To open an existing solution:
1. Click on the Open an existing solution option in the Home panel or select Open‐>Solution from the File menu.

2. Select the ".waSolution" file solution from the open file dialog.
The solution opens in the Home panel:

Any files that were opened when you closed the solution will be reopened automatically.

Close a solution
Only one solution can be open at a time in Wakanda Studio. To close a solution that you have opened in Wakanda Studio, you can:
Select Close Solution from the File menu.
or
Click on the close box in the Solution Explorer's tab:

or
Open another solution and the current one will be closed automatically.
If any files that are open in tabs have been modified and you haven’t saved them yet, the following dialog appears:

To save the changes to the modified files in the list, click the Save All button. To not save the changes to these files, click the Don't Save button. If you click
the Cancel button, the solution will remain open and the modified files will not be saved.

Project
In this chapter, we discuss how you create a Wakanda project in a solution as well as add or remove it from a solution in Wakanda Studio. We also show you
how to create a JS Module for your project.
For more information about projects, refer to the Project chapter.

Create a project
To create a new project for your solution, you can:
Select New‐>Project from the File or
Select New‐>Project from the solution's contextual menu.
The New Project dialog appears:

Add a project to a solution
If you have an existing Wakanda project that is not in your current solution, you can add it to the solution. To do so, select Add an Existing Project to
Solution from the solution's contextual menu.

In the open file dialog, select the project's “{Project Name}.waProject” file and click Open.
The selected project will be included in your solution and will appear in the Solution Explorer as in our case after adding "Project1" to our solution:

Remove a project from the solution
To remove a project from a solution, click on the project folder in the Solution Explorer and select Remove from Solution from the project’s contextual
menu.

The following dialog appears asking you to confirm your choice:

Afterwards, your solution contains the other project(s) it contained previously:

Note: The project folder including its files and folders will be left intact on your computer; however, the reference to the project will be removed from the
solution.

Run a project
You can run the main Page Prototype for your project by clicking on the Run Page button in the toolbar.

Wakanda Server is started (if it was not already started) and the "index" page in your "web/prototype" folder is published either in a tab in Wakanda Studio or
in your default browser.

Create a JS module for your project
To create a JS Module for your project:
1. Select New > JS Module or click on the New JS Module button in the toolbar.
The following dialog appears:

2. Enter a name for your module.

3. Create a RPC Module or a Service by selecting the appropriate check box.
The JavaScript file for the module whose name you entered is created and saved directly in your project.

For more information about RPC modules, refer to Publishing RPC functions.

Directory
You create the users and groups for your solution in the Directory directly or by using the Directory API.

Add a user
You can create a new user:
In the Directory or
Using the Directory API.
In the Directory
To create a new user:
1. Go to the Users section of the Directory.

2. Click the New button in the toolbar.
3. Enter the Login Name and Full Name in the list:

4. Then, go to the User Properties area to add a password for the new user:

5. When you click in the Password field, another password field appears along with the Save and Cancel buttons.

6. Save the changes to the Directory.
The password entered must be equal in both the New Password and Confirm Password for you to be able to save it.
A representation of the hash key created for the password entered is displayed in the User Properties:

If you want to add a thumbnail to a user:
1. Click on the thumbnail.
2. Select an image from the Open File dialog.
3. Click the Open button.
You can also drag and drop an image file from your computer to the thumbnail.
The chosen image will appear in the User Properties as shown below:

Note: The thumbnail image that you choose is copied into your solution's “Directory_userThumbnails” folder.
Using the Directory API
To create a user in our solution, use the addUser( ) function:

var newUser = directory.addUser("smith", "abc123", "John Smith"); // pass the login name, password, and full name
directory.save(); // then save the changes

Remove a user
You can remove one or more users from the Directory:
In the Directory or
Using the Directory API.
In the Directory
To remove one or more existing users from the Directory:
1. Go to the Users section of the Directory.

2. Select one or more users in the Users list.
3. Click on the Remove button.
The selected users are removed.
4. Save the changes to the Directory.
Using the Directory API
To remove a user from the Directory, use the remove( ) function:

var myUser = directory.user( "smith" ); // retrieves the user
myUser.remove(); // removes the user
directory.save(); // then save the changes
If you'd like to remove more than one user, you must retrieve the user and call the remove( ) function for each user that you want to remove.

Add a group
You can create a new group:
In the Directory or
Using the Directory API.
In the Directory
To create a new group:
1. Go to the Groups section of the Directory.

2. Click the New button in the toolbar.

3. Enter the Group Name in the list:

4. Save the changes to the Directory.
Using the Directory API
To create a group in our directory, use the addGroup( ) function:

var newGroup = directory.addGroup("marketing", "Marketing"); //name and display name
directory.save();

Remove a group
You can remove a group from the Directory:
In the Directory or
Using the Directory API.
In the Directory

To remove an existing group from the Directory:
1. Go to the Groups section of the Directory.

2. Select the group in the Groups list.
3. Click on the Remove button.
The group is removed.
4. Save the changes to the Directory.
Using the Directory API
To remove a group from the Directory, use the remove( ) function:

var myGroup = directory.group( "Marketing" ); // retrieves the group
myGroup.remove(); // removes the group
directory.save(); // then save the changes

Add a user to a group
You add a user to a group:
In the Directory or
Using the Directory API.
In the Directory
To add a user to a group:
1. Go to the Users section of the Directory.

2. Select the checkbox next to the Group's name in the Belongs to groups section.

Or
1. Go to the Groups section of the Directory.

2. Select the checkbox next to the User's name in the Includes users section.

Using the Directory API
To add a user to a group, use the putInto( ) function:

var newUser = directory.addUser("smith", "abc123" , "John Smith");
var newGroup = directory.addGroup("marketing","Marketing"); // creates a new group
newUser.putInto("marketing"); // adds the user to this group
directory.save(); // then save the changes

Remove a user from a group
You remove a user from a group:

In the Directory or
Using the Directory API.
In the Directory
To remove a user from a group:
1. Go to the Users section of the Directory.

2. Deselect the checkbox next to the Group's name in the Belongs to groups section.

Or
1. Go to the Groups section of the Directory.

2. Deselect the checkbox next to the User's name in the Includes users section.

Using the Directory API
To remove a user from a group, use the removeFrom( ) function:

var myUser = directory.user( "smith" ); // retrieves the user
myUser.removeFrom("Marketing"); // removes the user from this group
directory.save(); // then save the changes

Include a group in a group
You include a group in a group:
In the Directory or
Using the Directory API.
In the Directory
To include a group in a group:
1. Go to the Groups section of the Directory.

2. Select the checkbox next to the Group name in the Includes groups section.

Using the Directory API
To include a group in a group, use the putInto( ) function:

var myGroup1 = directory.group("sales"); // get Sales group
var myGroup2 = directory.group("marketing"); // get Marketing group
var newGroup = directory.addGroup("finance", "Finance"); // create Finance group
myGroup1.putInto("finance"); // put the Sales group into the Finance group
myGroup2.putInto("finance"); // put the Marketing group into the Finance group
directory.save(); // then save the changes

Datastore Model
You can either create your model (datastore classes, attributes, methods, etc.) using the Data Model Editor or the Model API.

Create a datastore class
You can create a datastore class:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor

To add a new datastore class, click on the

button.

After this datastore class is created with its ID attribute, you can directly edit its name in the datastore class panel or in the Properties tab.

It is suggested to use a singular word for your datastore class name and the plural form of the same word for the collection. If you enter “Employee” as the
Class Name, Wakanda enters “EmployeeCollection” as the Collection Name.

For more information, refer to the Datastore Classes chapter.
Using the Model API

You can create a datastore class by using the DataClass( ) function in the Model API. In your project's "model.js" file, you can write the following code in
which you specify the collection name as its first parameter:

model.Employee = new DataClass("EmployeeCollection");

Delete a datastore class
You can delete a datastore class:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
To delete a datastore class, click the

icon that appears when you hover over the datastore class in the Datastore Classes area:

An alert will appear that you must confirm to complete the process. The most basic alert is the following:

Once you confirm the deletion of the datastore class, it will be deleted permanently from your model.
Using the Model API
You can delete a datastore class by removing the line that defines the datastore class using the DataClass( ) function in the Model API.

Rename a datastore class
Once you have created a datastore class, you can rename it:
In the Data Model Editor or
Using the Model API.
You can freely rename a datastore class at any time even if data has already been stored in it.
Important Note: If you have created any datastore class or relation attribute datasources, you will have to update the Datastore class and Relation

attribute fields manually on the Page. For more information, refer to Datastore Class Datasources and Relation Attribute Datasources. If you have renamed
an attribute, it must be changed if it was used in any of the widgets even though it was correctly updated in the datasource.
In the Data Model Editor
To rename a datastore class:
1. Double‐click its name in the datastore class's title bar in the Model:

2. Modify its name.
Or
1. Select the datastore class and view the Properties tab.

2. Modify its name.
After you change the datastore class name, it is modified in the Model and the Properties tab:

By default, Wakanda adds the “Collection” suffix to the datastore class name to create the Collection Name.
For more information, refer to the Datastore Classes chapter.
Using the Model API
You can rename a datastore class by using the DataClass( ) function in the Model API. In your project's "model.js" file, if you have the following code:

model.Abbr = new DataClass("AbbrCollection");
model.Abbr.ID = new Attribute("storage", "long", "key auto");
You can edit the datastore class name and collection:

model.Abbreviation = new DataClass("AbbreviationCollection");
model.Abbreviation.ID = new Attribute("storage", "long", "key auto");

Create a scalar attribute
You can create a scalar attribute:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor

To add a scalar attribute to your datastore class:
1. Select a datastore class,
2. Click on the

icon in the Attributes bar of the Datastore Class or click the

button in the toolbar,

3. Enter a name for the attribute, and
4. Select a type for the attribute.

To save the new attribute, hit Tab. If you want to add another attribute to the datastore class, hit Return.

Using the Model API

You can create a scalar attribute by using the Attribute( ) function in the Model API. In your project's "model.js" file, you can write the following code:

model.Employee.firstName = new Attribute("storage", "string");
Note: Before adding an attribute, you must first create a datastore class. Refer to Create a datastore class.

Create a calculated attribute
You can create a scalar attribute:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
To add a scalar attribute to your datastore class:
1. Select a datastore class.
2. Click on the

icon in the Attributes bar of the Datastore Class or click the

button in the toolbar.

3. Enter a name for the attribute.
4. Select a type for the attribute.

To save the new attribute, hit Tab. If you want to add another attribute to the datastore class, hit Return.

5. Select “Calculated” from the Attribute type drop‐down list for an attribute:

6. Click on the

icon to define in which file you want to create the code for the calculated attribute's event:

7. The initial code is entered automatically in the JavaScript file that you specified:

8. Enter the following code:

return this.firstName + " " + this.lastName;
In the Data Model Editor, the calculated attribute has a blue icon next to it as shown below:

For more detailed information about how to enter code for the calculated attribute events, refer to the Calculated Attribute section in the Wakanda Server‐
Side Concepts manual.
To delete the code related to a calculated attribute's event, you must do so in the JavaScript file that you specified.
Using the Model API
You can create a calculated attribute by using the Attribute( ) function in the Model API. In your project's "model.js" file, you can write the following code:

model.Person = new DataClass("PersonCollection");
model.Person.ID = new Attribute("storage","long", "key auto");
model.Person.firstName = new Attribute("storage","string");
model.Person.lastName = new Attribute("storage","string");
model.Person.fullName = new Attribute("calculated","string");
model.Person.fullName.onGet = function()
{
return this.firstName + " " + this.lastName;
}

Create an N‐>1 relation attribute
You can create an N‐>1 relation attribute:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
An N‐>1 relation attribute relates one entity in a datastore class to one entity in another datastore class. In our case, each employee has only one employer.
To create an N‐>1 relation attribute so that we have a relation between Employee and Company datastore classes:
1. Create a new attribute, in our case, we named it "employer".
2. Select "Company" from the type list.

Once we select “Company,” a matching 1‐>N relation attribute is created automatically in the Company datastore class:

By default, the 1‐>N relation attribute is named “employeeCollection".
Using the Model API
You can create the relation attributes by using the the Attribute( ) and DataClass( ) functions in the Model API. In your project's "model.js" file, you can

write the following code to duplicate the relation attribute we created above:

model.Employee = new DataClass("EmployeeCollection");
/*define other attributes*/
model.Employee.employer = new Attribute("relatedEntity", "Company", "Company");

model.Company = new DataClass("CompanyCollection");
/*define other attributes*/
model.Company.employeeCollection = new Attribute("relatedEntities", "EmployeeCollection", "employer", {reversePath:true});

Create a 1‐>N relation attribute
You can create a 1‐>N relation attribute:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
An 1‐>N relation attribute relates one entity in a datastore class to multiple entities in another datastore class. In our case, each company has multiple
employees.
In our case, we want to create a 1‐>N relation attribute that contains all the employees in the Company datastore class:
1. Create a new attribute in the Company datastore class, which we named "staff'.
2. In the type column, select "EmployeeCollection".

Once we select “EmployeeCollection”, we are asked to create the matching N‐>1 relation attribute is created automatically in the Employee datastore
class. By default, the datastore class name is entered, but you can enter an attribute name to be created in the Employee datastore class.
3. Enter "employer".

Our 1‐>N relation attribute is created as shown below:

Using the Model API
You can create the relation attributes by using the Attribute( ) and DataClass( ) functions in the Model API. In your project's "model.js" file, you can write
the following code to duplicate the relation attribute we created above:

model.Employee = new DataClass("EmployeeCollection");
/*define other attributes*/
model.Employee.employer = new Attribute("relatedEntity", "Company", "Company");
model.Company = new DataClass("CompanyCollection");
/*define other attributes*/
model.Company.staff = new Attribute("relatedEntities", "EmployeeCollection", "employer", {reversePath:true});

Create an N<‐>N relation
You can create a N<‐>N relation:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
An N‐>N relation attribute allows you to have complex data structures. Here is our initial datastore model:

To create the N‐>N relation, you can proceed with the following steps
1.
2.
3.
4.

Create a new attribute in the N<‐>N class (in our case "InvoiceItem"), named "itemPart".
Define its type as "Part".
Create a new attribute in the N<‐>N class (in our case "InvoiceItem"), named "itemInvoice".
Define its type as "Invoice".
In both cases the 1‐>N relation attribute is automatically created in the "Part" and "Invoice" datastore classes.

In our case, we have the “InvoiceItem” datastore class that has a relation attribute in the “Invoice” and “Part” datastore classes:

Using the Model API
You can create the N<‐>N relation by using the Attribute( ) and DataClass( ) functions in the Model API. In your project's "model.js" file, you can write the
following code to duplicate the model we created above:

model.Invoice = new DataClass("Invoices");
model.Invoice.ID = new Attribute("storage", "long", "key auto");
model.Invoice.invoiceDate = new Attribute("storage", "date");
model.Invoice.total = new Attribute("storage", "number");
model.Invoice.lineItems = new Attribute("relatedEntities", "InvoiceItem", "itemInvoice", {reversePath:true});
model.InvoiceItem = new DataClass("InvoiceItemCollection");
model.InvoiceItem.ID = new Attribute("storage", "long", "key auto");
model.InvoiceItem.quantity = new Attribute("storage", "number");
model.InvoiceItem.itemPart = new Attribute("relatedEntity", "Part", "Part");
model.InvoiceItem.itemInvoice = new Attribute("relatedEntity", "Invoice", "Invoice");

model.Part = new DataClass("Parts");
model.Part.ID = new Attribute("storage", "long", "key auto");
model.Part.name = new Attribute("storage", "string");
model.Part.cost = new Attribute("storage", "number");
model.Part.itemsInvoice = new Attribute("relatedEntities", "InvoiceItemCollection", "itemPart", {reversePath:true});

Create a recursive relation attribute
You can create an recursive relation attribute:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
A recursive relation attribute relates one entity in a datastore class to another entity in the same datastore class. In our case, each employee has a manager.
In our example, we want to create a manager for each Employee:
1. Create a new attribute and name it "manager".
2. In the type column, select "Employee".

Once we select “Employee,” a matching 1‐>N relation attribute is created automatically in the Employee datastore class:

By default, the 1‐>N relation attribute is named “employeeCollection”.
3. Rename this attribute to “directReports”.

Using the Model API
You can create the recursive relation attribute by using the Attribute( ) and DataClass( ) functions in the Model API. In your project's "model.js" file, you can
write the following code to duplicate the recursive relation attribute we created above:

model.Employee = new DataClass("EmployeeCollection");
/*define other attributes*/
model.Employee.manager = new Attribute("relatedEntity", "Employee", "Employee");
model.Employee.directReports = new Attribute("relatedEntities", "EmployeeCollection", "manager", {reversePath:true});

Delete an attribute
You can delete an attribute:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
To delete an attribute, click the

icon that appears to the left when you hover over an attribute:

Once you confirm the deletion, the attribute will be deleted from the datastore class.
Note: If the attribute you are deleting was extended, it will be deleted from the derived datastore classes as well.
Using the Model API
You can delete attribute by removing the line that defines the attribute by using the Attribute( ) function in the Model API.

Create an alias attribute
You can create an alias attribute:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
To add an alias attribute to your datastore class, you must first already have an N‐>1 relation attribute in the same datastore class. To create an alias
attribute, add an attribute and enter the relation attribute’s name as the type.
1. Add an attribute to the datastore class and give it a name. In our case, we named it "employer".
2. Select the relation attribute's name as the type.

3. Type a "." to display the list of attributes in the company datastore class

4. Select "name" and hit Tab.

Using the Model API
You can create an alias attribute by using the Attribute( ) function in the Model API. In your project's "model.js" file, you can write the following code:

model.Employee.employer = new Attribute("alias", "string", "company.name");
Note: Before adding an alias attribute, you must first create an N‐> 1 relation attribute Refer to Create an N‐>1 relation attribute.

Extend a datastore class
You can extend a datastore class:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor

To extend a datastore class:
1. Choose Extend {Datastore Class Name} from the datastore class’s settings menu.

2. Rename the derived datastore class and hit Tab.

The inherited attributes and methods are displayed under the title “Inherited from {Derived Datastore Class Name}”. All the alias, calculated, and relation
attributes are included. If there are any datastore class methods in the extended datastore class, they too are added in the Methods section with the same
title, “Inherited from {Derived Datastore Class Name}”.
You can add relation attributes to your derived datastore class and remove inherited attributes. A removed attribute is grayed out and has a line through its
name and type (as shown in the section below).
Using the Model API

You can extend a datastore class by using the DataClass( ) function in the Model API. In your project's "model.js" file, you can write the following code to
extend the "Employee" datastore class to create the "Manager" datastore class:

model.Manager = new DataClass ("Managers", "public", "Employee", {
restrictingQuery: { queryStatement: "status == 'manager'" },
allowOverrideStamp : true
});
Note: Before adding an attribute, you must first create a datastore class. Refer to Create a datastore class.

Remove an inherited attribute
You can remove an inherited attribute:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
To remove an inherited attribute from a derived datastore class, click on the attribute to first display the Properties tab and check the Remove checkbox.

Once you have done so, the attribute name and type are grayed out with a line through each, as shown in our example for the gender attribute below:

When you remove an inherited attribute, you can no longer access it as if it were deleted from the datastore class.
Using the Model API
You can remove an inherited attribute by using the removeAttribute( ) function in the Model API. In your project's "model.js" file, you can write the
following code to first create the datastore class, extend it, and then remove one of the inherited attributes:

model.Employee = new DataClass("Employees");
model.Employee.ID = new Attribute("storage", "long", "key auto");
model.Employee.firstName = new Attribute("storage", "string");
model.Employee.lastName = new Attribute("storage", "string");
/*define other attributes*/
model.Employee.salary = new Attribute("storage", "number");

model.Manager=new DataClass("Managers", "public", "Employee"); // Extend the Employee datastore class to create the Manage
model.Manager.removeAttribute("salary"); // Remove the salary attribute

Override a property of an inherited attribute
You can override a property of an inherited attribute:
In the Data Model Editor or
Using the Model API.
In the Data Model Editor
To override a property of an inherited attribute by modifying the value defined for the derived datastore class:

Once you have overridden a property, it appears in bold and is underlined. To clear the overridden value, click on the

icon next to the property.

Using the Model API
You can remove an inherited attribute by any of the attribute functions in the Attribute section of the Model API. In your project's "model.js" file, you can
write the following code to first create the datastore class, extend it, and then override one or more of the inherited attribute's properties:

model.Employee = new DataClass("Employees");
model.Employee.ID = new Attribute("storage", "long", "key auto");
model.Employee.firstName = new Attribute("storage", "string");
model.Employee.lastName = new Attribute("storage", "string");
model.Employee.lastName.unique = true;
/*define other attributes*/
model.Employee.salary = new Attribute("storage", "number");

model.Manager=new DataClass("Managers", "public", "Employee"); // Extend the Employee datastore class to create the Manage
model.Manager.lastName.unique = false; // Override the attribute's property

Create a datastore class method
You can create a datastore class method:
In the Data Model Editor or
Using the Model API.

In the Data Model Editor
To add a datastore class method:
1. Click on the
icon in the Methods tab of the datastore class's Properties area,
click on the
icon in the Methods area at the bottom of the datastore class itself, or
click on the New Method toolbar button.
The following dialog box appears:

2. Define the following settings for the new datastore class method:
Method name,
Path to the file in which the code will be stored, and
Object (entity, collection, or class) to which the method will be applied.
In the "Model.js file, the following entry is added:

include("./Model/Company/Company-methods.js");
A JavaScript file named "{DatastoreClassName}‐methods.js" is opened:

model.Company.entityMethods.method1 = function() {
// Add your code here;
};
The new method appears below any existing methods:

By default, the method’s scope is “Public on Server.” You can change its scope by setting it in the scope property in the JavaScript file.
If you want to modify the name of the datastore class method, you must do so in the JavaScript file.
Note: If you enter a space, it will be replaced by an underscore. The datastore class method’s name must be unique and start with a letter, and can contain
only numbers and letters. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Note: Datastore class method names are case‐sensitive: “CheckEmployee” and “CheckEMPloyee” are not equal.
For more information, refer to the Datastore Classes chapter.
Using the Model API
You can create a datastore class method for your datastore class by using the collectionMethods, entityMethods, and methods functions in the Model API. In
your project's "model.js" file, you can write the following code to create a datastore class method:

model.Company.entityMethods.method1 = function() {
// Add your code here;
};
If you want to modify the scope for a datastore class method, you can use the scope function.

model.Company.entityMethods.method1 = function() {
//Add your code here;
};
model.Company.entityMethods.method1.scope = "public";
If you want to modify the permissions for a datastore class method, refer to the Define permissions chapter.

Permissions
You can define the permissions for your model, datastore class, attribute, or datastore class method in the Datastore Model Designer or directly in the
"Permissions.waPerm" file.

Define permissions
You can define the permissions for the following elements:
model
datastore class
datastore class method
attribute
You define the permissions either in the Datastore Model Designer or directly in the "Permissions.waPerm" file.
In the Datastore Model Designer

To define the permissions:
1. Go to the properties panel. In our example, here is the Model's properties:

2. Select the group from drop‐down menu.

For more information about the specific permissions, refer to Permissions
In the Permissions file

To define the permissions:
1. Open the project's "Permissions.waPerm" file.
2. Add the code for the specific permissions. In our example, we define the "Accounting" group in the "read" action for our Model.

<permissions>
<allow action="read" groupName="Accounting" groupID="470CC9D4697E4E6EB3837C0F2216F3BA"
resource="Model" temporaryForcePermissions="false" type="model"/>
</permissions>

Delete permissions
You can delete the permissions for the following elements that you previously defined:
model
datastore class
datastore class method
attribute
You delete the permissions either in the Datastore Model Designer or directly in the "Permissions.waPerm" file.
In the Datastore Model Designer
To delete the permissions for a specific element:
1. Go to the properties panel
2. Click on the
icon.

In the Permissions file
To delete the permissions:
1. Open the project's "Permissions.waPerm" file.
2. Remove the line of code that specifies the element's permissions.

Force temporary permissions
You can force the temporary permissions for a datastore class. For more information about forcing temporary permissions, refer to Forcing temporary
permissions.
In the Datastore Model Designer
To force temporary permissions:
1. Go to the properties panel
2. Check the Force temporary permissions checkbox.

In the Permissions file
To force temporary permissions:
1. Open the project's "Permissions.waPerm" file.
2. Add the following code for the permissions. In our example, we define the "Accounting" group in the "read" action for our Mode and selected the Force
temporary permissions checkbox.

<permissions>
<allow action="read" groupName="Accounting" groupID="470CC9D4697E4E6EB3837C0F2216F3BA"
resource="Model" temporaryForcePermissions="true" type="model"/>
</permissions>

Page Prototypes
In this chapter, we show you how to interact with the Page Prototypes in your project. You design the interface for your prototype by creating one or more
Page Prototypes. For more information, refer to Page Prototype.
URL for the Page

When you run or debug your page, you can also access it by entering its name directly. If your page's name is "company.waPage", its URL is:
http://127.0.0.1:8081/prototype/company.waPage/index.html.

Create a Page Prototype
To create a new Page:
1. Select Page from the New menu or click on the

button in the Wakanda Studio toolbar.

By default, the destination folder is the currently selected project's WebFolder.
2. Enter a name for the Page.
3. Select Desktop, Smartphone, or Tablet in the Create view for dropdown menu:

4. Hit the Create button.
The Page is created and opened in the Prototyper:

The "{Page Name}.waPage" folder is created and will contain the Page's HTML file, its package.json file and the "styles" folder in which the Page's CSS
information will be stored:

When you add an event to the Page or to a widget on the Page, the "scripts" folder is created and the "index.js" file is created.
Note: The name for the HTML, CSS, and JS files are dependent on the view. For the desktop view, all page names are "index", e.g. "index.html", "index.css",
and "index.js". For the smartphone view, the file name is "index‐smartphone" and for the tablet view it's "index‐tablet".

Create a View for a Page
A view allows you to publish your Page automatically to the desktop, a smartphone, or a tablet.
To create a view for an existing Page:
1. Select the view (desktop, smartphone, or tablet) to create from the dropdown menu:

The new view of the Page is opened in a tab.
A new HTML file, a "package.json" file, and a CSS file in the "styles" folder are added to your Page's folder as shown in our example after we added a "tablet"
view:

For more information about creating a custom View for your Page, refer to Routing Pages.

Run a Page Prototype
To run a Page Prototype:
1. Open a Page Prototype in the Prototyper.
2. Click on the Run button.

The current view (Desktop, Smartphone, or Tablet) is run in your default browser.
If you want to run your project's "index" page, you can click on the Run Page button in the toolbar.

If in the Prototyper, your Page Prototype appears as shown below:

When it's published, the same Page Prototype appears as shown below in your default browser:

Debug a Page Prototype
When you debug your Page Prototype, it is opened in your default browser and "?debug=1" is added at the end of your Page Prototype's URL. You can debug
your Page Prototype by either activating the debugger or by debugging the Page Prototype.
To enable the Debugger, select Use Debugger from the Run menu.
If you want to debug your Page Prototype and you have not enabled the Debugger:
1. Open your Page Prototype in the Prototyper.
2. Click on the Debug button in the toolbar.

The Page Prototype opens in your default Web browser and adds "?debug=1" at the end so that you can debug your Page Prototype.

Widgets
In this chapter, we discuss how you add and delete widgets from an existing Page Prototype in your project.
For more information about widgets, refer to the Prototyper ‐ Widgets chapter.

Add a Widget to the Page Prototype
In the Prototyper, you can add a widget to the Page Prototype in the following three ways:
Drag and drop a widget from the Widgets area onto an empty space in the Designer Workspace.
Select a widget in the Widgets area and then draw it to a specific size on the Designer Workspace.
Double‐click on a widget in the Widgets area.
Here is the Widgets area:

Delete a widget from the Page Prototype
To delete a widget from the Page Prototype:
1. Select the widget(s) on the Page Prototype and hit the Delete key on your keyboard,
2. Select the widget(s) on the Page Prototype and select Delete or Delete widgets from the contextual menu, or
3. Click on a widget in the Page Prototype's Outline and select Delete widget from the contextual menu.

All the widget's styles and JS code will also be deleted.

Datasources
In this chapter, we discuss how you create, duplicate, and delete datasources from an existing Page Prototype in your project.
For more information about datasources, refer to the Prototyper ‐ Datasources chapter.

Create a datasource
You can create a datastore class, relation attribute, array, variable, and object datasource for a Page Prototype. After the datasource is created, you can
change its name in the Properties tab.
Create a datastore class or relation attribute datasource

To create a datastore class and relation attribute datasource:
1. Click on the New Datasource button in the toolbar and select the datasource type:

or
Click on the

button in the Datasources area:

or
Click on the

button in the Model area:

2. Select Datastore Class or Relation Attribute, the following dialogs appear:

or

3. Select a datastore class or relation attribute to create it.
The datasource is created.

Create a variable, array, or object datasource

To create a variable, array, and object datasource for a Page Prototype:
1. Click on the New Datasource button in the toolbar and select the datasource type:

or
Click on the

button in the Datasources area:

The datasource is created.

Duplicate a datasource
Once you have a datasource created on your Page Prototype, you can duplicate it. To do so:
In the datasource's contextual menu, select Duplicate datasource:

The datasource will be duplicated and displayed in the Datasources list. Only the datasource itself is duplicated, not any of its other properties or events.

Delete a datasource
To delete a datasource, select Delete datasource from the datasource's contextual menu.

If the datasource is referenced in a widget, you will get the following warning:

If you click on the Yes button, the datasource is deleted from the Page Prototype and is removed from any widget on the Page Prototype that is using it.

Web App
In this chapter, we show you the main steps for building a Web app based on the default files created in each project.
The Web app is located in your project's web/app folder:

You edit the main HTML file and views using the HTML/CSS Editor and then develop your web application using the Angular‐Wakanda connector in the
JavaScript Editor.

Edit your Web app's main HTML file
To edit your Web app's main HTML file:
1. Open the web/app folder in your project.
2. Double‐click on the index.html file, which opens in the HTML/CSS Editor.

To customize this main HTML file, you can:
1. Modify the ng‐app directive to the name of your AngularJS application.
2. Modify the ng‐controller directive, which is the name of your AngularJS application controller.
3. Add your HTML code in the div tag where the ng‐controller directive was declared.

Edit your Web app's main JS file
To edit your Web app's main JS file:
1. Open the web/app/scripts folder in your project.
2. Double‐click on the app.js file, which opens in the JavaScript Editor.

The default controller "myController" is where you can add your code using the Angular‐Wakanda connector.

Run your Web app

To run your Web app, you can click on the Run Page button:

You can specify if you want to view it in a new tab or your default browser by holding down the Run Page button and selecting one of the two options in the
dropdown menu:

Running the page in a new tab
When you run the Web App in a new tab, it's main Page is displayed as shown below:

To refresh it, just click on the

button.

Mobile App
In this chapter, we show you how to create a Mobile app in your project.
The Mobile App is located in your project's mobile folder:

You edit your mobile app's HTML files using the HTML/CSS Editor and then develop your mobile application with the Angular‐Wakanda connector using the
JavaScript Editor.

Edit your mobile app's main HTML file
Open your mobile app's main HTML file, "index.html", which is in your project's mobile/www folder:

Here are some details about this HTML file:
CSS files:You can add your CSS files in the same location where the default ones are located.
Ionic and Cordova JS files: The Ionic and Cordova JS files for your mobile app.
Mobile app's JS files: The mobile app's JS files for its controllers and services.
AngularJS app: In the body tag, you can include your code for your mobile app.
Navigation bar for your mobile app: Ionic directive for navigation bar.
Ionic directive for views: Ionic directive for views.
The navigation bar depends on the platform your mobile app is running on. On Android, the navigation bar is displayed at the top while on iOS, the navigation
bar is at the bottom (as shown here):

Preview your mobile app
To preview your mobile app, first select to preview your Android and/or iOS App in Wakanda Studio or in your default browser:

Then, click on this button to preview it:

If you select iOS in a new tab, your mobile app appears as shown below:

To refresh your mobile app, click on the

button.

Run your mobile app
To run your mobile app, first select if you want to run it on the Android emulator or the iOS simulator:

Then, click on the Run button.
Your mobile app opens in either the Android Emulator or the iOS Simulator (shown below):

Build your mobile app
First define if you want to build your mobile app for iOS and/or Android:

Afterwards, click on the Build button to build your mobile app.
A message appears in the Console when it is complete.

When you click on the link, the build's folder will be opened in your Finder:

